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Opening Statement:

I, Mara Zebest, am preparing this report at the request of 
Maricopa County Sheriff ’s Offi  ce in support of the Cold Case Posse 
investigation.

The PDF birth certifi cate document released by the White House 
(shown in Figure 1) is a completely manufactured and fabricated 
computer generated image. The same source fi le was used to 
print a copy handed to the AP (shown in Figure 2), in which the 
AP scanned in the version handed to them. A third photograph 
version (Figure 3) was touted by Savannah Guthrie who claimed 
to have held and felt the seal on the document, but the original 
Internet posted images have been scrubbed.

The White House wants us to believe the PDF document started 
out in printed form on security paper retrieved from Hawaii—but 
this is not possible. All three versions manifest itself as a printed 
document only when the PRINT button is pressed from within 
the original manufactured document fi le. This would account 
for the transformation of a document containing diff erent color 
backgrounds, and the ability to print with or without safety paper 
pattern (by turning a layer on or off ).

There is no doubt in my mind that this computer generated image 
never started out as a paper source document and was never 
scanned in as described by the White House—it was digitally 
created and manufactured.

The bulk of this report will explain the evidence to support this, 
which will include the following points:

 Inconsistencies within text characters: All anti-aliased text (in 
a color scan), or all bitmapped text (in a black & white scan)—
not a mixture of both which is impossible in a legitimate 
document. Image noise should also be consistent throughout.

 Chromatic aberration absent: A color scanned document 
would display chromatic aberration. This is physics and occurs 
in all color scans but is absent in Obama’s PDF document.

 Layers: A normal scan is a fl at fi le and does not contain multiple 
layers. The Obama PDF contains 9 layers and grouped to a 
clipping mask layer.

 Links: Indicate that components were pasted into the fi le, 
rotated, and resized.

 Clipping Mask Path hides image information: Proof of 
manipulation.

 Safety paper and white halo: Manufactured in fi nal steps.

Figure 2: A printout was given to AP which they scanned

Blue background color 

and no safety paper

Figure 1: PDF fi le released from White House

Green safety paper 

background

Figure 3: Savannah Guthrie photo claim to verify document

Safety paper background 

with a gray/blue color
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Figure 5: Font Properties of Obama’s PDF fi le

Document Font Properties 

of original PDF fi le

Document Font Properties 

after OCR Text Recognition

Figure 6: Font Properties dialog after OCR Text Recognition 

Figure 4: Search for text is not recognized—No OCR applied

Search word in Find box

No text found in fi le

The OCR Argument Not a Factor!

OCR—which stands for Optical Character Recognition—will scan a 
document for text and convert any images of text to live (editable) 
text.

After OCR is applied to a PDF in Adobe Acrobat Pro, the text 
responds as if it is in a Word document. The OCR text can be 
selected, changed, copied and pasted. The Obama PDF document 
as downloaded cannot be edited in the aforementioned manner. 
Note: Adobe Acrobat Pro has PDF editing functions, but Adobe 
Acrobat Reader does not.

Additionally, if the PDF had been scanned using OCR software; one 
would be able to search the document with keywords and if the 
text exists in the document, then those keywords would be found.

Figure 4 shows the keyword “Live” typed in the FIND box, and even 
though the word “Live” exists in the Certifi cate of Live Birth title, a 
dialog box responds that “no matches were found.”

When viewing the font properties dialog box in Figure 5, no fonts 
are listed. If OCR was used, the image area would be converted to 
recognized fonts in the document and the fonts would be listed. 
The dialog box is empty, indicating that Obama’s PDF fi le does 
not recognize any text. This dialog box can be viewed by going 
to the File menu > Properties, then click on the Font tab in the 
Document Properties dialog box.

Font-based text can be created after a fi le has been processed 
through the OCR Text Recognition feature in Adobe Acrobat. To 
run the OCR feature, go to the Document menu and select OCR 

Text Recognition, and then click Recognize Text Using OCR. 
Acrobat will then perform a scan on the document and convert any 
text found in the image to editable text. Note that applying OCR 
Text Recognition will alter the appearance of the characters in the 
conversion from image to text.

Figure 6 shows that all the fonts recognized during the process are 
now listed in the Font Properties dialog box.

Figure 7 shows another search (after OCR is applied) on the 
keyword “Live” typed in the FIND box. The word “Live” is found and 
highlighted within the Certifi cate of Live Birth title.

Figure 7: Search for text is recognized after OCR is applied

Search word in Find box

Text found in OCR fi le

http://whitehouse.gov/sites/default/files/rss_viewer/birth-certificate-long-form.pdf
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Introduction to Basic Terms

Let’s briefl y examine three terms related to graphic programs: 
Noise, Anti-aliasing, and Bitmap

Noise v No Noise

Scanned images will have a consistent noise. Any inconsistencies 
in noise would be a strong telltale sign of tampering. When looking 
at an image at a normal zoom level (100%) colors may appear as 
one color of any particular area of an image. Zooming in closer to 
the area, consistent noise is easily apparent in the slight variations 
of color from neighboring pixels that make up each color (shown 
in Figure 8). This is the natural noise level for this image. Note that 
it is consistent throughout the image; variations can be seen for 
neighboring pixels of each color area in the original image. 

In contrast, Figure 8 also shows an example of no noise as a result 
of digital manipulation. Two pixels were sampled to match colors 
within the image. Using a paint brush tool in Adobe Photoshop, 
a streak of each sampled color is drawn across the image area. 
Clearly the lack of noise in the digital brush strokes is inconsistent 
with natural noise of the image. Components added digitally to an 
image do not contain noise. All neighboring pixels for the sample 
paint strokes in Figure 8 are solid in color with no variation—not 
even the slightest of variations. In order to avoid detection when 
editing an image, an experienced professional will need to mimic 
the noise to match the document. One common method used is to 
access the Add Noise fi lter found on the Photoshop Filter menu. 
This was not done in the Obama PDF fi le. If this was a legitimate 
color scan, noise would be consistently displayed throughout the 
entire document.

Bitmap (or Aliasing) v Anti-aliasing

Figure 9 off ers a visual explanation of aliasing (or bitmap text) 
contrasted with anti-aliasing.  Notice that aliasing is the visual 
stair-stepping of edges that occurs in an image which yields a 
jagged edge. Anti-aliasing is the smoothing of jagged edges 
in digital images by averaging the colors of the pixels at the 
boundary edges.

Also notice the transition of pixel colors that occur in Figure 8 
where contrast colors bump up next to each other. This color 
transition (averaging of color pixels) makes the lines appear 
smooth when viewed at a normal viewing level. Without 
anti-aliasing to soften this line edge transition of colors, images will 
have a choppy jagged edge quality (aliasing or bitmapped quality). 
Anti-aliasing is either applied globally (to an entire image) during 
scanning—or not at all.

Figure 10 is a perfect example of an inconsistency that occurs with 
image manipulation. The numerical characters 064 seen in the 
Figure are all aliased or bitmapped, and the 1 is anti-aliased as 
well as containing noise.

A color scan would produce anti-aliased results universally. While 
it is possible to use a bitmap setting when scanning, the results 
would create a black and white image—no color present. A bitmap 
setting would turn every pixel to on or off —white or black. So if a 
bitmap setting was used in a scan, then there shouldn’t be a color 
background, along with varying colors in the text outside the 
grayscale range? All text color values have green tone values—not 
black or grayscale.

Figure 9: Aliasing (or bitmap) and anti-aliasing

Figure 8: Painted brush strokes in digital scan lack noise

Image noise

Paint strokes—no noise

Figure 10: Bitmap edges are jagged v smooth anti-aliased edge

Bitmap edges are jagged Anti-aliased edges are smooth

Noise

No noise
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Scanner Chromatic Aberration

What is chromatic aberration? This occurs when diff erent 
wavelengths of light are refracted diff erently as it goes through 
a lens or prism during the scanning process. Light is refracted 
diff erently as the scanner encounters one side of a contrasting 
color (particularly with text) compared to the opposite side of the 
contrasting color.

In simpler terms, Figure 11 is an example of Chromatic Aberration 
in which the scanner produced warm red-ish color values at 
the bottom and left edges of the text, and similarly the scanner 
produced cool blue-ish color values around the top and right 
edges of text transitions. Chromatic Aberration can be seen at a 
high zoom level in color scans such as the AP version of Obama’s 
BC—but this chromatic aberration is NOT present in Obama’s PDF 
released by the White House.

Because the AP version displays chromatic aberration, this is an 
indicator that the AP did receive a printed hard copy of the BC from 
the White House and scanned whatever was presented to them. AP 
did not do anything wrong. They simply scanned what was handed 
to them.

It’s important to note that the AP version does NOT have a security 
safety paper background pattern, but rather a baby blue colored 
background. This sudden diff erence in background color/pattern 
is another inconsistency that could NOT happen if the document 
was simply scanned with no further manipulation and released by 
the White House—but this inconsistency would only happen if the 
White House document is a manufactured fi le.

Applying the Terms Reviewed

A key problem with the document, as presented, is that it is riddled 
with inconsistencies. Scanning a document without manipulation 
produces an image with qualities that are consistent globally 
(throughout the entire image). Amateurish image manipulation 
will reveal local (specifi c areas) of inconsistencies or odd artifacts.

Another example of anti-aliased text containing noise for the letter 
“R” mixed with surrounding bitmap text in Figure 12. The white 
halo eff ect surrounding the text with no chromatic aberration is 
also a strong indicator that the document was manipulated (more 
on the white halo later).

Figure 13 displays text color inconsistencies in dates, along with a 
misspelling in the offi  cial stamp text—”TXE” instead of “THE.” While 
it may be argued that the misspelling is merely a function of the 
stamp ink applied unevenly, the odds signifi cantly decrease that 
this would occur on both vertical bars that aff ect both sides of the 
“H” character. Both sides pull in substantially displaying an “X.” The 
stamp also sports suspicious markings in the “Alvin” signature that 
has been referred to as a “happy face.”

Figure 14 off ers a contrast image of Alvin Onaka’s stamp in which 
the words are spelled correctly and no “happy face” markings in 
the “Alvin” signature. The “Ph.” spacing between the “P” and “h” is 
diff erent in both signature images (the period spacing as well).

Also, the stamp version displayed in Figure 13 is a solid bitmap 
layer—no signs of texture (ink stamp on paper) can be detected. 
Some semblance of texture would be refl ected in an image 
scan (even with optimization applied), but this overall quality of 
texture—the ink stamp on paper as seen in Figure 14—is absent 
from the Obama PDF.

Figure 11: Scanned text and Chromatic Aberration

Cool blue color at the upper edges

Warm red color at the lower edges

Figure 14: http://factcheck.org/2008/08/born-in-the-usa/

No spelling error

Alvin’s signature 

without smiley face?

Figure 13: Examples of text inconsistencies

Color variation evidence of manipulation

Spelling error on stamp

Alvin’s signature suddenly 

develops a smiley face

Green text color values

Figure 12: Obama PDF viewed in Acrobat at 1600% zoom level

Noise, anti-aliasing, bitmap inconsistency 

in text—and no chromatic aberration

http://abcnews.go.com/images/Politics/ap_obama_certificate_dm_110427.pdf
http://factcheck.org/2008/08/born-in-the-usa/
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Layers: Flat, Man-made, and Optimized

Attempts to suggest optimization explains the presence of layers in 
the Obama PDF is simply not true. While it is true that optimization 
can cause layers, it is not true that optimization explains the layers 
displayed in Obama’s PDF. The layers in Obama’s PDF clearly display 
a decision-making process that would be present with image 
manipulation.

A simple defi nition for optimization is a process that applies 
suitable compression settings to reduce fi le size.

As stated—optimization can cause layers—but in the case 
of optimization; the process of how the document is layered 
is completely computer-generated based on programming 
algorithms. Thus, there are certain predictable patterns.

Before examining the Figures, it might help to explain that there are 
two types of graphic programs: Raster-based and Vector-based. 
Raster-based is a fancy word for pixel-based which is the strength 
of a program like Adobe Photoshop. Whereas Adobe Illustrator 
is a vector-based program—meaning it relies on mathematical 
interpretations. Illustrator operates diff erently than Photoshop in 
that lines or shapes drawn in Illustrator are referred to as paths—the 
mathematical equations that defi ne the line, line segment, or shape. 
With this in mind, when a pixel-based image is opened in Illustrator, 
a path is generated to defi ne the outer boundary border of that 
object. This is why you will see sub-layers in the screen capture 
Figures with a Path title that corresponds to the visible blue (default 
color) rectangle-shaped border edges of an object (in the displayed 
image).

The AP fi le version of Obama’s PDF in Figure 15 will serve to 
represent a scanned document and when opened in Illustrator, 
there is only one link, and one layer; the layer breaks down to 
display the following sub-layers: 

 A boundary edge Path—the blue border surrounding the image

 And the fl attened Image

Figure 16 shows a crucial diff erence in the number of layers 
displayed in Obama’s PDF fi le (compared to the AP fi le): Obama’s 
PDF has nine links and nine sub-layers (NOTE: The paths are actively 
displayed in the image). In addition to the nine sub-layer objects, 
a clipping path is at the top of the sub -layer list. The clipping path 
groups all the remaining sub-layers below. Note the location of the 
clipping path in the image, which will be explained further on the 
next page. It’s presence within the fi le and applied in a manner to 
hide portions of the image also refl ects image manipulation.

Another crucial diff erence in the number of layers occurs when 
optimization is applied to the AP scanned image in Figure 17. 
There is an unreasonable amount of layers generated. Note despite 
resizing the Links and Layers panels, there is still a scroll box which 
scrolls the length of the empty scrolling bar area (to off er a sense of 
how many layers extend beyond the current view).

Examine how the layers divide the image into pieces. It is analogous 
to taking a scissor and cutting the image into random rectangles.

Finally, notice that Figure 17 calls out the top layer as a bitmap layer 
(which means it contains one color value only), while all remaining 
layers are color layers (contains multiple color values). One bitmap 
layer and multiple color layers are typical optimization behavior; 
but the reverse is true in Obama’s PDF in which it contains multiple 
bitmap layers and only one color layer.

Figure 15: Normal one-layer scan document behavior

Layer 1 includes the following sub-layers:

Outside border edge boundary path

One Link

One fl at image layer

Outside border Path

One fl at image

Figure 16: Multiple layers and links in Obama’s PDF

Multiple links

Multiple sub-layers

Outside border path

Clipping Path

Clipping Path layer

Figure 17: AP layers and links after optimization is applied

Huge amount of links

Insane number of color sub-layers

No logic to layer 

object decisions

Scroll box

Scroll box

One bitmap sub-layer at top
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The Clipping Mask Path

Let’s return to the previously mentioned Clipping Mask Path. The 
term mask refers to defi ning parts of an image to be hidden from 
view (rather than have to delete unwanted parts). Any vector shape 
can be used as a clipping path—in this case the rectangle path 
shape seen in Figure 18 defi nes an area that acts like a window: 
Anything within the shape border is visible, and anything that falls 
outside its boundary is not visible. A benefi t derived from using a 
clipping mask is it allows the mask to be reposition at any time to 
show or hide diff erent parts of the artwork. A clipping mask that 
hides image information from view only occurs in a manual process 
to manipulated a document. If a clipping mask is generated in an 
optimized fi le—it will never hide information.

Figure 18 displays the clipping mask as the only visible path 
when the Obama PDF is fi rst opened—all other path objects 
behave as a group attached to the clipping path. To move and see 
these objects separately—the clipping mask group needs to be 
released—or ungrouped.

Figure 19 shows an open Layers panel (to display the sub-layers). 
A right-click inside the clipping mask off ers a menu option to 
Release Clipping Mask. Notice that releasing this path not only 
exposes the other grouped path objects, but suddenly uncovers 
additional background pattern that spills outside (and beyond) the 
clipping mask path boundary—proof of image manipulation.

X-Ray Scanner Vision

Tom Harrison, a software designer, published a report that 
examines the top two sub-layer objects. Without a doubt, the 
implications of these two sub-layers are clear indications of image 
manipulation. This cannot happen in a normal document. At fi rst 
glance these layers appear to be empty—but this is not the case. 
These layers contain odd random white pixel information, while 
the pixels under the white dots show no disturbance of safety 
paper pattern (on the bottom layer). This is simply not possible in a 
normal scan and can only happen in image manipulation.

Tom Harrison off ers the following analogy in his report: Try to have 
someone take a picture of a person holding a football hidden 
behind their back, not visible to the camera. Will you ever be able 
to extract the person from the photograph and still see the football 
revealed? Of course not. However, if a picture is taken of a football, 
and a separate picture is taken of the person, layers can be used 
to “hide” the picture of the football behind the person (using a 
program like Photoshop). By placing the picture of a person on a 
layer “in front of”—or on top—of the layer containing the football 
in the document—the football would not be visible to the casual 
viewer unless the layer of the person is turned off .

Using the football analogy, look closely at Figure 20—a close-up 
view to reveal numerous white pixels in the top layer object. 
Additionally, these pixels are bitmapped rather than displaying a 
soft blending quality to transition into the background pattern—
another indication that the white pixels are not a normal part of 
the background pattern. 

Figure 21 shows the white dot layer turned off  to expose the 
undisturbed safety pattern in the background (under the white 
pixel dots). To paraphrase Mr. Harrison, no scanner in the world 
has x-ray vision that can detect uninterrupted safety paper pattern 
under another object (such as the random white dots). 

Figure 18: Obama PDF opened in Illustrator with clipping mask

Collapsed icon

Visibility icon

Clipping Path

Figure 19: Clipping Mask group released and sub-layers displayed

Expand icon

Release Clipping Mask Group

Clipping Path

Figure 20: Zoom view of top layer reveals white pixels

Top layer selected

First link actively selected

Layer object path

White pixels display

Layer visibility on

Figure 21: Layer turned off  reveals uninterrupted pattern below

First link deselected

Layer object path turned off 

White pixels disappear: 

Pattern pixels uninterrupted

Layer visibility off 

http://help.adobe.com/en_US/Illustrator/14.0/WS714a382cdf7d304e7e07d0100196cbc5f-644aa.html
http://www.adobe.com/designcenter/video_workshop/?id=vid0057
http://www.wnd.com/2011/07/326565/
http://www.wnd.com/files/2011/07/110726whitedots.pdf
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Figure 22: Target layers and objects for date and certify stamps

Selected active layers

Selected active links

Date stamp Certifi cation stamp

Figure 23: Layers allow for moving the date and certify stamps

Date & certifi cation stamps moved

Figure 24: Background layer with white halos can also move

Background selected & moved

Stamp Layer Appearance

The main purpose and strength of layers is they allow parts 
of an image to be isolated to make it easy to repositioned, or 
adjust visibility (on or off ) independently of surrounding image 
layered parts—thus layers are a powerful image manipulation 
tool. It makes sense to have a date and a certifi cation stamp on 
separate layers—to move, rotate, or reposition for the purpose 
of manipulation and alteration. Figures 22–24 demonstrate how 
objects can be moved around independently. The Obama PDF 
has a clean separation of text isolated on each layer, unlike the AP 
optimization layer results for the same information in Figures 25–

26. The layer results seen in the Obama PDF cannot be duplicated 
through optimization, but can be easily duplicated (and explained) 
with an understanding of image manipulation.

The date stamp and certifi cation stamp are the selected layers in 
Figure 22. The Links and Layers panels verify the selection along 
with the active blue paths that display around the layered objects.

Figure 23 demonstrates that the objects can be moved 
independent of the background (or other text items). Note that in 
the Obama PDF, the text for the certifi cation stamp is completely 
and independently separated onto its own layer. The same is true 
of the date stamp. This is a clear and important indication of image 
manipulation in which each of these items can be manipulated 
independently of the surrounding background layer. This clean 
separation can only be accomplished through image manipulation 
of document elements.

Figure 24 shows the background layer can also be selected and 
moved independently from the stamp and date layer elements. 
The white halos are a part of the background layer since white is 
the typical color present when building a background layer. Thus, 
whenever the safety paper pattern is not present, the typical color 
displayed in the absence of pattern will be white.

Automation v Manual Manipulation

Figure 25 and Figure 26 shows the lack of predictability when 
an automation process chops up an image and generates layers 
during optimization. As previously mentioned, the AP fi le opens 
with the appearance of a normal scanned document containing 
only one layer. For this reason, the AP fi le was used to demonstrate 
what happens when optimization is applied. After the optimization 
process, the AP fi le displays a multitude of layers.

Most of the black text extracts onto one bitmap layer at the top of 
the layer list. This top text layer is turned off  in Figure 25. Note that 
the text does not separate cleanly onto one layer. Remnants of text 
remain behind on a variety of the many multi-color layers in the list 
that still have their visibility turned on in Figure 25. Additionally, 
the top text layer contains a large portion of all document text and 
optimization fails to separate text according to usefulness. In other 
words, all the stamp text does not reside on its own layer—nor is 
there a diff erent layer for the date text—and again, no clean and 
complete separation.

Figure 26 has the top text layer visibility turned back on again, 
but instead, one of the bottom background layer’s visibility is 
turned off  this time. The selected paths show how there’s no 
human quality to the logic in dividing information into layers—the 
machine is deciding based on an automated process.

Figure 25: Optimized lacks the human element in layering

Bottom layers selected—text layer off 

Figure 26: Text layer turned on and one background layer off 

Text layer on—one background layer off 
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White Halo Creation

The white halo eff ect presents two common questions; why is 
there a white halo, and what caused it? Before answering the 
former question, let’s address the latter.

The white halo could simply be a function of a selection created 
around all the text—before fi lling the background layer with a 
green safety pattern.

The green safety pattern could have easily been applied to the 
background layer without any selection—thus a solid pattern 
would have covered the entire background layer—without a white 
halo. But for some reason, a white halo eff ect was generated—
either through an active selection when creating the background, 
or through an enhancement process, or a combination of both. 
As might be expected, the creation of a background using a text 
selection is easily demonstrated with step-by-step Figures.

Figure 27 shows the demonstration fi le set-up. The stamp text 
from the Obama PDF fi le was copied (from Illustrator) and pasted 
into a new Photoshop fi le on a layer that is above a solid white 
background layer. Note the two layers in the Layers panel: Stamp 
Text layer and the Background layer (currently fi lled with white).

When working in a graphic program, if you want to apply any 
changes to an image, you have a choice to use a selection for the 
target area, or to make changes without a selection. If there is no 
selection, then any changes can be applied to the entire image 
without any restrictions. If a selection is created, the changes are 
limited to the selection area only. Analogous to selecting text in 
a Word program to apply a change, such as bold formatting; the 
text is fi rst selected, and the bold formatting is then applied to the 
selection only.

In this example, a selection will be created around the text as the 
next step shown in Figure 28. Any object separated on a layer 
can easily be used to create a selection of that object. Simply hold 
down the Ctrl key and click on the layer thumbnail—in this case 
click on the Stamp Text layer. A selection that resembles marching 
ants appears around the text. The next step is to expand the 
selection to include a little extra space surrounding the text. This 
can be accomplished from the Select menu, using Modify, and 
then choosing the Expand option (also seen in Figure 28).

The Expand Selection dialog box displays in Figure 29 which allows 
a user to specify how many pixels to expand the selection. Since, 
the idea is to surround the text by a small area, the amount entered 
in this example will be 2 pixels.

The expanded selection in Figure 30 currently surrounds the 
text. However, the current selection area needs to remain white 
since the ultimate goal is to apply a pattern fi ll to the surrounding 
background area—not the surrounding text area. Therefore, the 
selection needs to be reversed—also known as inverse—to ensure 
the pattern will fi ll everything on the background layer except the 
text area.

Go to the Select menu shown in Figure 30. The Inverse option is 
chosen. The selection is now ready to fi ll with a color, or a pattern, 
or even another scanned image (such as a scan of security safety 
paper). Everything but the text area is now selected. For purposes 
of this demonstration, the next step will defi ne a safety paper 
pattern and fi ll the background layer using the current active 
selection.

Figure 27: A two-layer stamp text fi le created to demonstrate

Bottom layer: White background

Top layer: Certifi cation stamp text

Figure 28: A text selection created and selection expanded

Text is selected

Ctrl+click on layer thumbnail

Figure 29: Expand Selection option—expanded 2 pixels

Expand Selection dialog box

Figure 30: Next the selection needs to be inversed

Text selection expanded by 2 pixels

Selection Inverse option
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Safety Paper Creation

In a program such as Photoshop, a selection can be fi lled with a 
solid color of choice, an image, or a pattern can also be defi ned as a 
fi ll option. It should be noted that a full sheet of safety paper could 
have been scanned and used without going through steps to defi ne 
it as a pattern—but a pattern can be easily defi ned from an existing 
image as an alternative method. Most likely, there was access to 
a sample of safety paper when creating the Obama PDF. It’s not 
necessary to reinvent the wheel—the current Obama PDF fi le will be 
used as the source pattern for the purpose of this demonstration.

The Obama PDF is temporarily opened in Figure 31 and a square 
selection is made to isolate a portion of the pattern that will tile 
easily—which means that when the selected area is fi lled repeatedly 
next to each other, the pattern continues seamlessly—without any 
noticeable disruptions in the pattern. With the selection active, the 
Defi ne Pattern option is selected from the Edit menu. The Obama 
PDF fi le is closed and no longer needed.

Back to the demonstration fi le shown in Figure 32; with the 
Background selected as the active layer, the Fill option is chosen 
from the Edit menu.

In the Fill dialog box, the Pattern option from the Content list is 
chosen in Figure 33.

The safety paper pattern defi ned earlier in Figure 31 is also chosen in 
the Fill dialog box in Figure 34. Click OK to complete the eff ect.

The results in Figure 35 show a slight white halo outside the text.

In Figure 36—the Stamp Text layer’s visibility is turned off , and the 
marching ants are deselected (Ctrl+D). The white halo eff ect was 
easily manufactured in less than a minute, in less time than it took to 
read the explanation.

In summation, the security paper background layer was added 
as the last step to create the illusion of an image in which text 
was imprinted on security paper. However, the text had in fact 
been placed and arranged on a solid white background. This last 
application gives a created image the false appearance of being an 
offi  cial document.

Figure 31: Selection used to defi ne a pattern

Selection of a sample pattern area

Defi ne the selection as a pattern

Figure 33: The Pattern option is used in the Fill dialog box

Pattern Fill option chosen

Figure 34: The defi ned pattern chosen from Custom Pattern list

Custom Pattern chosen

Figure 32: Use the Edit menu to launch the Fill dialog box

Selection inversed

Fill option chosen

Background 

layer active

Figure 35: The pattern fi lls the selection area

Background 

contains pattern fi ll

Figure 36: Turn off  the text layer: White halo eff ect is displayed

Stamp Text visibility off 

White halo eff ect
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Some Final Thoughts

The previous exercise demonstrated how the white halo could be 
created, but there can be a multitude of ways to accomplish the 
same task in a program such as Photoshop. Whether or not the 
exercise presented is the defi nitive method is not the main point.

The exercise was presented as a possible solution to the question: 
How did the white halo get into the document? But actually, the only 
question that matters is: why is the white halo there at all? Any 
offi  cial document obtained by legitimate procedures and scanned 
would not have the white halo.

As previously stated, every anomaly can be easily explained as a 
manufactured document. Not only does this document display 
attributes that it was completely manufactured digitally, but there 
is strong evidence that a master fi le exists as a source fi le. What is 
meant by a master fi le? A master fi le is a fi le in which all the objects 
still exist on separate layers (in other words, more layers and 
information than seen in the Obama PDF sub-layers).

For example, in the Obama PDF, the bottom layer contains the 
background pattern with some text elements merged onto 
that layer. In the master fi le version, the text still remains on a 
separate layer—NOT merged with the background layer. It is 
highly probable that this master fi le also contains the short form 
certifi cate layers (which would explain the problems seen in the AP 
version of the fi le).

Figure 37 and Figure 38 demonstrate that the AP version of the 
long form certifi cate contains a diff erent set of problems as follows:

 A sudden shift to a diff erent background

 Safety paper pattern in the shadow at the left edge—but not in 
the document background

 Short form embedded into the printout—Figure 38 is an 
enhanced version which allows the details to be seen more 
easily

Once again, all of these additional problems displayed in the 
AP version would not occur if the source document presented 
to the AP had been a legitimate scanned document without 
manipulation. However, all three problems would easily be a result 
of a manufactured source fi le—in which layers from a master fi le 
were turned off  or mistakenly left on.

Figure 37: Some extra remnants visible in the AP version

Background color 

magically shifts to blue

Forgot to turn off  safety-paper 

layer in manufactured shadow

Forgot to turn off  a 

short  form layer

Figure 38: Enhancement applied to easily see short form

Enhancement applied to 

display short form elements




